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1 About the chapters of this
manual

In the following, we give a brief summary of each chapter in this manual.
These summaries will help you find the information you are looking for.

Chapter 2 “An introduction to HELIOS PCShare” gives background informa-
tion about the components that make up PCShare.

Chapter 3 “HELIOS Admin” briefly shows how to manage PCShare related
tasks such as configuring SMB volume settings, etc. with the HELIOS admin-
istration program.

Description of the server software modules

Chapter 4 “PCShare SMB file and print services” describes the function, the
configuration, and the operation of the file server. It presents the HELIOS
PCShare Client Tools and explains how the administrator can define access
privileges for PCShare Windows users. In addition, it gives information about
WINS, WINS Proxy, and Browsing.

Chapter 6 “Client tools” presents the HELIOS PCShare Client Tools and also
HELIOS LanTest.

Chapter 7 “Preferences” lists the most important preferences of PCShare and
explains what they effect when set.

Additional information

Appendix A “Connect Windows clients to the PCShare server” gives instruc-
tions on how to set up the IP configuration settings between Windows clients
and PCShare.
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Appendix B “Technical notes” contains additional technical information that
addresses experienced UNIX users.

Appendix C “Glossary” explains some product related terminology.
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2 An introduction to HELIOS
PCShare

PCShare allows easy integration of powerful servers into Windows networks.
It provides an extremely fast, reliable, feature-rich Windows compatible file
and print server to unlock UNIX performance for Windows clients.

Note: HELIOS PCShare runs on top of the foundation provided by HELIOS Base.
Please read the Base manual for installation instructions and other important
details.

The TCP/IP protocol stack

The TCP/IP protocol stack forms the backbone for the PCShare services. It
is responsible for basic TCP/IP network functions, including those of net-
work routing. PCShare supplies additional service protocol routing for WINS,
Browsing, and DHCP services. This permits PCShare to be used to intercon-
nect several physically separate TCP/IP network interfaces, and transparently
pass information between them as required.

File server

Windows SMB/CIFS support ensures full compatibility with standard Win-
dows programs, including multi-user applications. Sharing files and printers
is simple and straightforward because there is no additional software neces-
sary for Windows clients. Windows NTFS Unicode and file streams support
ensures compatibility with modern Windows applications. Mac metadata is
accessible via SFM compatible streams. UNIX permissions and quota are
fully supported. A PCShare exclusive Explorer extension allows managing
UNIX file and folder permissions from the client.
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To network your host and thus your Windows computers with Mac computers
use EtherShare. To provide real-time remote file access for web clients, use
WebShare (see C “Glossary”).

HELIOS Admin server and HELIOS Admin

The cross-platform program HELIOS Admin is an administration tool which
can be used to configure PCShare from any of the connected client workstations.
It can also be used by regular users to check the configuration. However, they
are prevented from making any changes.

HELIOS Admin communicates with PCShare through the HELIOS Admin
server, which runs on the host while HELIOS Admin needs to run on a Java
capable host or client workstation. The communication between these two
programs takes place through a TCP/IP connection which allows managing
multiple servers remotely and supporting concurrent TCP/IP connections (see
“Logging on to the HELIOS Admin server” in the HELIOS Base manual).

WINS

PCShare can act as a WINS (Windows Internet Name Service), which is used
on a PC network to map names to IP addresses. It can provide name, TCP/IP
addresses, etc. when asked by Windows clients.

PCShare 2.5 client compatibility

There is a HELIOS service called “pcsdossrv”, which is meant for Windows
3.1 and DOS client compatibility. In earlier PCShare product versions these
so-called “PCShare native” clients were serviced by “pcsdossrv”.

Note: If you want to install PCShare 2.5 client compatibility, please refer to the
“ps20-eng.pdf” and “ps25-ad.pdf” manuals in the “manuals/old” subfolder
on your HELIOS installation CD.
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2.1 PCShare client applications

There are several HELIOS drivers and applications included for installation or
use on Windows network clients utilizing HELIOS server volumes and print
queues.

m The “HELIOS PCShare Client Tools” are HELIOS extensions to the Win-
dows Explorer file properties dialog, to enable setting file permissions,
color labels, and comments for files on PCShare network volumes.

m “HELIOS PCShare Search” enables easy Spotlight compatible searches
for server files by file name, text content, or meta data (described in
6.1 “HELIOS PCShare Client Tools”.

m Server administration via the HELIOS Admin application (described in
3 “HELIOS Admin”).

m HELIOS LanTest, a tool for testing and measuring the performance of file
system and print system services, is presented and described in 6.2 “HELIOS
LanTest”.

m The “HELIOS WebShare Manager” application, which facilitates project
collaboration, with automatic file synchronization, is described in its own
manual.

The “Client software installation checklist” (“HELIOS_Install_Checklist.pdf”)
lists all the options, and is included in the “Documentation” folder in the
“HELIOS Applications” volume.

System requirements for PCShare client applications are detailed on theHELIOS
Platforms web page.

http://www.helios.de/platforms
http://www.helios.de/platforms
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2.2 New PCShare features

For new features in the PCShare software see the HELIOS website:
www.helios.de Go to HELIOS Product Versions – New Features

For HELIOS Base, the foundation used by all HELIOS products, see the
HELIOS Base product web page:
www.helios.de Go to Products > Base

https://www.helios.de/web/EN/products/new-features.html
https://www.helios.de/start.html?lang_id=en
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3 HELIOS Admin

This cross-platform administration service is comprised of two components,
the HELIOS Admin server and the HELIOS Admin client.

The HELIOS Admin client is a convenient tool that allows configuring users,
groups, volumes, printer queues, etc., and which supports, due to its Java
heritage, various client platforms. For details see the chapter “HELIOS Admin”
in the HELIOS Base manual.

Note: By default, Java is not installed on current Windows workstations. In order
to run HELIOS Admin, a 64-bit Java must be installed on the client system.

3.1 General remarks

This chapter describes the use of the application HELIOS Admin to perform
PCShare related configuration, such as SMB volume settings, Windows printer
settings, etc. from any workstation in a convenient and secure way.

In order to use HELIOS Admin, the HELIOS Admin server must already be
running on the host you wish to configure. The HELIOS Service Controller is
configured to start this server automatically when the system is booted.

Other chapters in this manual describe how administrative work, which is
required to configure and maintain the PCShare system, can be carried out
directly on the host, e.g. by using “prefvalue” (see “HELIOS utility programs”
in the HELIOS Base manual). Most of these tasks can be carried out much
easier using HELIOS Admin from one of the workstations.
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HELIOSAdmin offers a high degree of convenience to the system administrator.
The application allows the host configuration to be represented graphically
with lists and windows. Using HELIOS Admin from any workstation or server,
users, groups, volumes, and printers can be created, configured and deleted.
You can also interrogate each PostScript printer for available resident fonts
and install downloadable fonts on the print server.

HELIOS Admin accesses and modifies the “Preferences” configuration file
just as if the changes had been made manually. However, HELIOS Admin and
the HELIOS Admin server have built-in safety checks to avoid conflicting or
invalid configuration settings.

HELIOS Admin has the additional advantage that almost all changes are
immediately effective, without having to restart the affected service.

Benefits:

m Any new HELIOS volume or printer will be available immediately.

m Any changes to HELIOS volumes, e.g. setting groups membership, will
be available immediately.

Potential drawbacks:

m Any changes to HELIOS volumes, e.g. removing or changing mount points,
switching characteristics to read-only or changes in groups membership
may result in side effects for PCShare clients, if the volume is still mounted.
This may range from write errors to volumes getting dismounted(!).

m Especially important: Removing access rights to volumes for clients that
still have documents open on that volume might cause damaged or only
partially saved documents.

Make it a habit to check the Active Users list prior to making any changes that
might affect connected users. In the Active Users list you can verify which
users have certain volumes in access.
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3.2 Server settings

General

General server settings are described in the chapter “HELIOS Admin” in the
HELIOS Base manual.

Mac

Mac related server settings are described in the chapter “HELIOS Admin” in
the HELIOS EtherShare manual.

Windows

In the Settings > Server Settings window (Fig. 3.1), in the Windows tab, you
can specify the Server Name and select the Domain/Workgroup (if not specified, the
system uses the host name as server name and “WORKGROUP” as workgroup
name). In addition, you may enter a description in the Comment field. The
Avoid Elections option is usually turned off. In case you do not want your
PCShare host to become LMB (Local Master Browser) check the flag Avoid

Elections. From the Default Client Charset pop-up menu choose the default
client character set which is used for non-Unicode clients and for protocols
not supporting Unicode, e.g. “Browsing”. From the IP Access pop-up menu
choose the desired IP access list for the server. This setting defines the access
list for SMB/CIFS clients. It allows selecting a list from pre-defined IP access
lists. See the HELIOS Base manual for creating/modifying IP access lists.
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Fig. 3.1: “Server Settings” window

WINS

The WINS configuration is described in 4.2.3 “Name resolution with WINS
proxy”. See the section WINS.

MDNS

mDNS server settings are described in the chapter “HELIOS Admin” in the
HELIOS Base manual.

SMTP

SMTP server settings are described in the chapter “HELIOS Admin” in the
HELIOS Base manual.

DHCP

The DHCP configuration is described in the HELIOS Base manual.
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3.3 Volume SMB settings

This chapter refers to SMB related volume settings only. For general informa-
tion on volume settings and instructions on how to change them see “Volume
settings” in the “HELIOS Admin” chapter of the HELIOS Base manual.

The Volumes tab shows all HELIOS volumes on the host (Fig. 3.2). TheHELIOS
Admin server automatically creates this list by inspecting volume-related
entries in the “Preferences” file (see “Volume preference keys” in the HELIOS
Base manual).

â Choose the Volumes tab. If it is not available, activate it in the Lists menu.

Fig. 3.2: Volumes list on host “ankh”

Changing SMB volume settings

Before changing SMB volume settings, make sure that the volume is not in use.
All users should unmount the volume, because changes take effect immediately
and this could lead to strange effects.

â Select the volume name, and choose Open from the File menu (or double-
click the volume name).
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The Windows tab displays the SMB information of the selected volume (Fig. 3.3).

Fig. 3.3: Windows tab on host “ankh”

The Windows visible checkbox determines whether the volume is visible at all
in the Windows “My Network Places”.

The SMB Name field allows specifying the name by which the volume is published
in an SMB environment, and which is visible in the volume listing in the SMB

Name column (Fig. 3.2). The SMB volume name can have up to 63 characters.

By default, the PCShare server will hold files open in its cache even if a
client closes a file. If you need to prevent PCShare from doing so, e.g. for
compatibility reasons with some UNIX applications, the Close Option can be
activated, forcing the server to close files immediately on client close.

From the SMB Charset pop-up menu you can choose the SMB character set
which is used by the volume: PC850, EUC-KR or SJIS.
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Note: This setting is only required for Windows clients that do not support Unicode.

All HELIOS volumes are Unicode UTF-8 encoded. The SMB character set
describes what encoding should be used for non-Unicode clients or protocols.

3.4 Printer spooler settings

This chapter refers to SMB related printer settings only (see 4.4 “Print server
utility programs”). For general information on printer settings, e.g. how to
create and delete printers see the “HELIOS Admin” chapter in the HELIOS
Base manual.

Fig. 3.4: Printers list on host “ankh”

The Printers list shows all HELIOS printer queues on the host (Fig. 3.4). The
HELIOS Admin server automatically creates this list by inspecting printer-
related entries in the “Preferences” file (see “Printer preference keys” in the
HELIOS Base manual).

â Choose the Printers tab. If it is not available, activate it in the Lists menu.
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Before changing printer data, make sure that the printer queue is currently not
in use.

â Select the printer, and choose Settings from the Printer menu (or double-
click the printer name while holding down the Alt key).

The Windows tab displays information about the selected printer (Fig. 3.5).

Fig. 3.5: Windows tab on host “ankh”

Windows SMB

The name of the Windows SMB printer (SMB Name) is specified in the Windows

– SMB section.

The Windows name of the printer only becomes visible in the network if the
Windows – SMB checkbox is active.

The SMB Name is the name by which the printer is known to the network. You
may optionally specify a printer driver in the field Driver Name. If you leave
this field empty, Windows may ask you to specify a driver.



3.5 Windows printer output settings 15

The driver name is usually identical with the PPD (PostScript Printer Descrip-
tion) name. If this name matches an existing driver name on the local Windows
client computer, Windows will automatically choose this driver.

3.5 Windows printer output settings

Windows Printer (Fig. 3.6) connects a server queue via TCP/IP to an SMB/CIFS
Windows workstation or print server.

â Choose Windows Printer (see also Windows SMB in 3.4 “Printer spooler
settings”) from the pop-up menu of the Interface tab.

Then specify the Computer Name, User Name, Password and Printer Name in the
respective fields. Computer Namemust be the WINS name, a valid DNS name or
the IP address in decimal. Likewise, User Name and Password must have valid
access rights on the remote SMB/CIFS printer. Finally click Save.

Note: Printer Name must be the shared name which may be different from the
name in the Windows printer list.

If the PostScript Printer option is switched off the job is sent as is (“raw”);
tasks that are usually done during printing, e.g. font inclusion, will be skipped.
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Fig. 3.6: Windows Printer connection
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4 PCShare SMB file and print
services

PCShare implements a Windows 2003 SMB/CIFS compatible file and print
server. The main goal of PCShare is to offer the highest compatibility for file
and print services, and to support all major Windows clients as well as DOS
clients with its native protocol.

The SMB/CIFS protocol is also used for named pipes where Microsoft pro-
vides additional protocols for their Exchange Server, Remote Procedure Calls,
Remote Registry, etc. PCShare implements file and print services only. If
PCShare should fail in a special workflow or application, please help to get
the problem reproducible by documenting a simplified test case and report it
to your HELIOS partner. Due to an incomplete documentation for the SMB/
CIFS protocol by Microsoft and continuously changing Windows versions
via updates and upgrades, PCShare is continuously enhanced by updates and
upgrades. Please ensure to verify problems against the latest version and
update level.

Authentication

The PCShare server uses the HELIOS authentication server which allows local
host users, NIS, LDAP and AD/PDC users. PCShare supports all required
SMB/CIFS user authentication methods, including Lan Manager, NTLMv1
and NTLMv2.

TCP/IP access lists

The PCShare server supports the default HELIOS TCP/IP access lists for its
services as well as a custom access list per volume to hide/show volumes for
remote users.



18 4 PCShare SMB file and print services

File access security

PCShare clients run with the effective authenticated user and group permis-
sions, which means UNIX file access permissions and user quota limits are
enforced by the operating system. UNIX file and directory permissions are
fully supported and can be managed in the PCShare tab of the Windows Ex-
plorer “Properties” dialog, using server host tools, from Macs connected via
EtherShare or from WebShare web clients. Each PCShare TCP/IP client runs
in its own process which provides higher process security in case of a protocol
failure.

Inherit permissions

For new files and folders, PCShare will automatically inherit file permissions
from the parent directory. For new directories, the “g+s” bit is set (if permitted).
This allows quota group enforcements.

UTF-8 volumes and Unicode

PCShare requires HELIOS UTF-8 volumes which are compatible with the
HELIOS EtherShare AFP server for Mac clients and HELIOS WebShare for
remote web clients. PCShare supports the Unicode protocol for Windows
clients allowing them to use the same file names compatible to Windows
NTFS volumes. File names can have up to 255 characters and short names are
supported for clients requiring it.

NTFS file streams

PCShare handles Windows NTFS file streams and related commands (cre-
ate/rename/move/remove). This enables enhanced compatibility with Win-
dows servers and NTFS as well as better cross-platform support. Windows
file streams are preserved even after a Windows file is modified by an Ether-
Share Mac or WebShare web client. The file streams are stored in the “.rsrc”
directory.

Attributes

PCShare supports the Windows file and directory attributes “System”, “Hid-
den”, “Archive”, “Read-only” and “Creation date”. These attributes are stored
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in the HELIOS resource file in the “.rsrc” directory. The attributes are stored
in an EtherShare and WebShare compatible format, i.e. in a hidden file which
is hidden as well for Mac or web clients.

“dt” tools

HELIOS Base includes batch tools to allow host batch compatible file man-
agement, e.g. “cp”, “mv”, “mkdir”, “rm” , “chmod”, “touch”. The “dt” tools
will handle additional file information like file streams, Windows attributes,
Mac resource information, and update the volume desktop database.

Desktop database

PCShare supports the HELIOS desktop database. Each volume contains a
desktop database file which keeps an index of all files with associated unique
file IDs.

File events

PCShare supports file events which are used by ImageServer hot folder scripts
and automatic OPI layout file generation. The events are generated based on
file suffixes and Mac file types. The ImageServer TCP/IP port 2002 allows
clients to be notified about file changes.

User Quota limits

User quota limits are enforced. The PCShare server reports the user quota
limited available disk space to its clients.

Volume backup

It is recommended to use a host based backup solution to backup PCShare
volumes. A host backup solution will backup all information including file
mode, owner and group. Some host backup solutions will automatically handle
the resource information and additional file streams when selecting individual
files. It is always safe to select complete folders for backup instead of single
files, this means all related streams and attributes will automatically be archived
because they are stored in the “.rsrc” subdirectory of each directory (see also
the “dt” tools sync capability in the HELIOS Base manual).
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A remote backup from Windows is possible but the UNIX owner, group and
mode information of files and directories is not supported by the SMB/CIFS
protocol and will therefore lead to default permissions in case of a restore.

Print spooling

PCShare will publish its printers via the SMB/CIFS printing protocol. Authen-
ticated Windows clients will automatically see all published printers in the
Windows Printers and Faxes list. After connecting to the shared printer queue
the Windows print manager will show the print jobs. Removing jobs is only
allowed by the owner or by admin users. It is recommended to use HELIOS
Admin for more advanced queue management. The PCShare specified printer
driver name allowsWindows clients to automatically install the required printer
driver if the driver name matches an installable driver within the Windows
driver path. HELIOS Base provides the HELIOS printing system used by
PCShare and all other HELIOS products. “lpr/lpc/lprm/lpq” compatible tools
allow inspecting and modifying print jobs/queues.

Windows Terminal Server (WTS)

The WTS provides multiple sessions for different users. It connects only once
to an SMB/CIFS server and multiplexes the different user sessions over a single
TCP/IP connection. The same technique is used for Windows XP user switch-
ing where different user sessions can connect to the same SMB/CIFS share.
PCShare has been tested with WTS and Windows XP sessions and supports
the user session switching feature over a single connection. In heavy duty
client environments, separate Windows clients (no WTS) have a significant
performance benefit over WTS sessions where the SMB/CIFS access is being
serialized by a single TCP/IP connection.

Windows oplocks

Using “oplocks”, Windows may cache the entire file until a second client
accesses the same file. PCShare supports Windows oplocks, EtherShare and
ImageServer will handle oplock cached files. Ensure that oplock files get
flushed before accessing their data. Accessing files manually via host tools
may not provide the correct data for files with oplocks. Use the “locktable”
command (HELIOS Base) to list all open files and oplocks attributes.
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File and record locking

Full Windows compatible file and record locking is provided by PCShare and
shared with EtherShare and other HELIOS programs to permit true cross-
platform file and record locking for Windows, Mac and mixed client environ-
ments. To provide fast and fully compatible file and record locking, HELIOS
stores all locks in a shared memory which allows accessing locks without
additional system calls. Windows and Mac require that every read or write of
bytes does not interfere with existing locks. Local server file access, NFS or
shared Sun storage locks are neither compatible with Windows file and record
locking nor with oplocks. Therefore the same data can only be published by
one active PCShare server.

Supported network clients

See a list of all PCShare supported network clients on the HELIOS website.

4.1 Server file system information

Case-sensitivity

The following table compares the behavior of the different operating systems
regarding the case sensitivity.

Preserve Ignore

OS X (HFS default) + +

OS X (UFS/Xsan) + –
Mac OS 8/9 + +

Windows + +

UNIX + –
MS-DOS – +

Table 4.1: Operating systems and the case-sensitivity of file names

http://www.helios.de/web/EN/support/platforms.html#client_os
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As Table 4.1 shows, there is no case preserving under DOS, i.e. file names
entered in lowercase will appear UPPERCASE in the directory listing. In
contrast to UNIX, the Windows (as well as Mac) operating system is not case-
sensitive when it looks for files or creates or opens them – if your application
looks for “Dave”, it will also find “dave”, and you cannot create a file “Dave”
and a file “dave” in the same folder in a local volume. Due to its UNIX heritage,
this is not the case for HELIOS volumes.
This distinction is normally not a problem – if an application has created e.g.
the file “Editor Prefs” and needs to open it again, it usually tries to open it
using the same name and not “EDITOR PREFS”. If an application cannot find
a file which it has created, and the file is visible under UNIX and in the Finder,
it is likely that case-sensitivity is to blame. If you are able to determine the
name of the file which the application is trying to open, you can often provide
a workaround by using a Mac/Windows link (alias) or by renaming the file.

4.2 PCShare WINS and browsing

4.2.1 Browsing

Name resolution through WINS (Windows Internet Name Service) or broad-
casts deliver the matching IP address to a given NetBIOS name, like a telephone
directory inquiry returns the telephone number to a given name.

To find out which IP address represents which NetBIOS name the following
procedure is applied:

Each host sends in regular intervals so called “Host Announcements” all over
the network. These are received by all computers on the subnet, but ignored
by all except for the LMB (Local Master Browser). From the received “Host
Announcements” the LMB generates the browse list, which contains all the
names known to the LMB. The browse list becomes visible e.g. in theWindows
My Network Places list.
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One or several BB (Backup Browser) are subordinate to the LMB for load
balancing purposes. Each BB requests the browse list from its LMB in regular
intervals.

Each client which would like to receive the browse list, e.g. because a user
opens the Windows My Network Places list, requests it arbitrarily from any
LMB or BB.

On each subnet of a domain there is an LMB and a certain number of BB
and clients. Domain in this context refers to theWindows NT Domain, not to
confuse with an Internet Domain.

The development of the browsing hierarchy is a dynamic process and cannot
be configured. Each host which would like to become LMB, and each host
which would like to obtain a browse list but – for any reasons – does not obtain
one, can enforce an election. However, unlike a political “election” here every
node votes for itself and does not give its vote to another. An election consists
of several heats. Each host votes for itself until it recognizes that another host
has cast a more important vote.

The importance of a vote depends, among other things, on the operating system
version and the uptime. A host running Windows NT Server “wins” before
Windows NT Workstation, and NT Workstation wins beforeWindows 98, etc.
In case of a “tie” the larger uptime and further criteria are decisive.

After a maximum of 4 heats the “winner” of the election is found and appoints
itself LMB, appoints further hosts BB, or divests existing BBs of their powers
with the target of an optimal load balancing.

A browse list is complete several minutes after the election. Therefore, frequent
elections have a detrimental effect and therefore should be avoided.

The LMB administers the browse list of its subnets. In order to make the hosts
of other subnets visible, all other LMB browse lists must come to each LMB’s
knowledge. For that purpose each LMB connects with the DMB (Domain
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Master Browser) and synchronizes its browse list in regular intervals with the
DMB. Thus, the local browse lists are assembled to a global browse list which
covers the entire domain. This process can take up to 1 hour.

The DMB is the only arrangement within the browser hierarchy which must
be configured. LMBs result from elections on a subnet by broadcasts. BBs
are appointed by the respective LMB. The DMB must always also be LMB on
its subnets. If the DMB loses the election another host becomes LMB. This
usually leads to malfunctions.

In each domain there is a PDC (Primary Domain Controller) which, among
other things, administers passwords. A PDC on the network can be found
by use of the Primary Domain Controller Location Protocol, a sequence of
special browsing packets and name resolution.

Microsoft determined that PDC and DMB have to be the same host. Because
an LMB cannot find the DMB on the network it looks for the PDC and so
relies on having found the DMB. See also Browsing in 4.2.3 “Name resolution
with WINS proxy”.

Thus, a Windows NT Server DMB is always also PDC. PDC functionality
is not yet implemented in PCShare – the DMB functionality however is. If
PCShare is to function as DMB, it must register itself with the WINS as PDC,
pretending PDC functionality, in order to be considered DMB from other
LMBs.

Important: If there is another PDC on the network, the PCShare server should under
no circumstances be configured as DMB or PDC!

Each WINS client must know the IP address of the WINS server, e.g. by static
configuration or DHCP.
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4.2.2 Name resolution with WINS

A NetBIOS name can be a group name, e.g. a Workgroup or a domain or a
unique name, e.g. a computer, a service or a user. ANetBIOS namemay consist
of uppercase characters as well as some special characters and is restricted to
max. 15 characters. If it is shorter than 15 characters it is appropriately filled
with blanks. The 16th byte is a type byte, from which one can detect whether
it concerns e.g. the name of a computer, of a user or of a service. Thus, each
NetBIOS name is exactly 16 bytes long.

To make a computer, service, etc. on the network recognizable, it must first
register itself. If another computer wants to access this name, it must do name
resolution. For this to work, the IP address of the WINS server must be known.
Under PCShare the WINS server address can automatically be delivered via
DHCP, when configured with HELIOS Admin.

A computer registers itself via WINS by sending a Name Registration Request
(unicast UDP). This datagram contains among other things the NetBIOS name
and an IP address. The WINS answers with a positive Name Registration
Response. This process is repeated in regular intervals (Name Refresh). If
Name Refresh is not executed in the determined time interval, the WINS
considers this client to have crashed or switched off, and removes its entry
from the data base. Similarly a client which is switched off should log out
with a Name Release Request from its WINS so that its name is immediately
removed from the WINS data base and not only after a time-out. This however
does not happen very often.

The WINS will reject a registration (negative Name Registration Response),
e.g. if a client wants to register a name which another client has already
registered successfully before. This leads then to an (possibly quite strange)
error message at the unsuccessful PC.

A client, which needs to get a name resolved, sends a Name Query Request
(unicast UDP) to the WINS. The WINS answers with a positive Name Query
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Response, which contains the IP address of the looked-up NetBIOS name or
with a negative response, i.e. the looked-up name is not known to the WINS
(anymore).

If name resolution with WINS fails the client still tries it with some Name
Query Requests which are sent as broadcasts. If the looked-up NetBIOS name
is located on the same subnet its carrier will answer with a unicast Name Query
Response.

If this still fails DNS (Domain Name System) can be used.

In a larger network several WINS may share the tasks, e.g. for reasons of
reliability or for load balancing purposes. These WINSs do replicate in regular
intervals their data bases among themselves, in order to always share the same
level of knowledge.

Note: A replication fromWINS is not implemented in PCShare at present, because
Microsoft keeps the required “WINS Replication Protocol” secret. PCShare
can be employed as exclusive WINS only.

4.2.3 Name resolution with WINS proxy

If the WINS is not known to PCs which are located on a subnet they can only
use broadcasts for name resolution. In this case a WINS Proxy can be used as
a link.

The IP address of the WINS must be known to the WINS Proxy. It listens on
its subnet for broadcasts and forwards these to the WINS. It incorporates a
local cache in order to hold network traffic within limits. Thus, the nodes on
the broadcast subnet can also resolve names of computers or services which
are on other subnets. However, this does not work the other way round.



4.2 PCShare WINS and browsing 27

The WINS Proxy should only be used for a transition period, until all nodes on
the subnet are correctly configured and communicate directly with the WINS.

The communication with the WINS Proxy puts unnecessary workload on the
network and can also cause additional problems. If a node gets more than one
response after a broadcast it regards this as an error, even if the responses are
correct and consistent, and rejects the received responses.

Nodes which do not communicate with the WINS broadcast their existence
in regular intervals on their subnet. The WINS Proxy can then forward these
broadcasts to the WINS. However, this does not lead to a registration of the
broadcast node with the WINS, it is merely checked whether a broadcast node
carries a name which a WINS client had already registered. If necessary, the
WINS Proxy refuses the broadcast node registration.

HELIOS Admin allows making adjustments which influence he behavior of
PCShare. Here, we discuss issues which affect name resolution and browsing.

IP access

For safety reasons it can be necessary to forbid computers with certain IP
addresses to access the PCShare server. However, this option should only be
used with caution because the structure of the browser hierarchy is a dynamic
process, and therefore it is often not predictable which host will take which
position in this hierarchy.

If any host requests a browse list but is prevented by the IP access list from
doing so, this may lead to a new election. For this, it is irrelevant whether a
user opened the Network Neighborhood list, it came by periodic testing of the
browse list or the rejected host is located on the same or another subnet.

Note: An inappropriately selected entry in the IP access list leads constantly to
new elections. In this case you will be unable to get a stable and reliable
browser hierarchy.
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Browsing

PCShare needs a NetBIOS host name as well as a NetBIOS domain name. If
not configured in a different way, the host name is the PCShare server name,
and the workgroup name is “WORKGROUP”:

PCShare will force – shortly after booting up – an election and try to become
LMB. This behavior can also be turned off:

Microsoft did not define a mechanism which allows to find the DMB on the
network. Instead, there is a mechanism (Primary Domain Controller Location
Protocol) to find the PDC on the network. Hence PCs rely on the fact that they
will thereby also find the DMB. On that score PCShare must pretend PDC
behavior (i.e. respond to this PDC Location Protocol).

But this is just a fake behavior since full PDC functionality is not implemented
in PCShare:

WINS

By default, PCShare is a WINS server, which is used on a PC network to
map names to IP addresses. It can provide name, TCP/IP address, etc. when
asked by Windows clients. If it is not the WINS server itself, PCShare must
know where to register itself and which arrangement is responsible for name
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resolution. WINS should only be switched on if PCShare is the only WINS
server on the network.

PCShare can also function as WINS Proxy. In case of doubt, WINS Proxy should
remain switched off. Only if WINS Proxy is configured the Proxy Registration

Check checkbox is available. This helps to avoid duplicate computer names.
Duplicate computer names in one network will not work reliably.

The Scope Identifier is a means to divide the flat NetBIOS name space into
sections, when NetBIOS over TCP/IP is used. An hierarchy as in the DNS
name space is however not realized. It defines a group of computers that
recognize a registered NetBIOS name. Computers with the same Scope ID
will be able to recognize each other’s NetBIOS traffic or messages.

4.2.4 Querying PCShare for WINS & Configuration information

With socket <ipaddress> 2003 or socket <hostname> 2003 a connection to the
master PCShare process can be established and “Name Binding Service”
configuration & status can be queried. The following short abstract shows how
certain information can be listed.

Note: In a complex network you may have to wait several minutes after starting
PCShare before a stable browsing hierarchy has been reached.

â Issue the command socket localhost 2003, type help for the command
overview and quit to leave.

Note: By default, the PCShare service port can only be reached from localhost.
See RemoteAccess in 7.1 “PCShare preferences”.
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After entering status the master PCShare server will respond with a status line
which lists the PCShare version incl. update level, start date and uptime of the
PCShare master process as well preference settings.

[PCShare server info: status]
'PCShare 6.0.0' pid:26517, running: 0m 13s, started Fri Nov 7
15:19:06 2014

Preferences:
dirs:16384 files:8192 clientFiles:4096 fileCache:4096
searches:128
Unicode Oplocks StreamLocks

forked child processes since start:0
no current child processes

Use help to list available commands:

quit Terminate session.

status Shows the master process status.

childs Shows current child/client processes.

if With if the configured TCP/IP interfaces are listed with TCP, broad-
cast and MAC address. If the interface is registered for PCShare
the column “reg” lists “+”, otherwise “-”.

wins With wins information about WINS will be listed as stored in
“HELIOSDIR/var/run/wins.db”, for example name and addresses,
expiration date as well as type and state. In case the PCShare server
is not WINS itself, this will return “No WINS entries”.

winsproxy With winsproxy information about WINS proxy will be listed, see
wins. In case the PCShare server itself is not WINS or there is
no WINS proxy information, this will return “No Proxy WINS
entries”.

winscl With winscl current connection information about WINS will be
listed, e.g. NetBIOS name, type and flags.

winstime With winstime information about WINS will be listed ordered by
time. See wins.
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brconfig With brconfig configuration information about the PCShare server
is listed. Apart from host name, domain name and comment which
are always listed, any changes to the default parameter settings are
listed also. For example, if the PCShare server is not WINS.

browse With browse all known browsing information is listed, e.g. domains,
hosts, LMB & BB.

4.3 Print to Windows workstation printers via SMB

4.3.1 smbif

“smbif” is the interface program for printers that are connected to the print
server through SMB. It is used for all printers (including PostScript printers
and imagesetters). “smbif” forms the link between the HELIOS LPR and
Windows printers.

Print jobs received by the print server from a workstation on the network
are processed and queued before being sent to the SMB printer through the
network again.

Due to print job spooling, it is more efficient to driveWindows printers through
the print server, rather than accessing them directly from the workstations. We
recommend that you select an appropriate name for the queue which shows
which printer it drives and also indicates that it is a queue and not the printer
itself. For example, add “spooler” to the queue’s name. See 3.5 “Windows
printer output settings”.
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4.4 Print server utility programs

4.4.1 pcfilter

The “pcfilter” program, which was designed to be used by the PCShare print
spooler, can be used to carry out print job filtering and character set translation
operations which are commonly required for different types of ASCII-printers.

Usage:
pcfilter <printer_name>

“pcfilter” is called on/from UNIX with command line options.

[-d] Filter out “Ctrl-D” in PS
[-f] Add “form feed” to last page
[-c crmapping] Map ’cr’ to ’crlf’, ’lf’ or ’lfcr’
[-l lfmapping] Map ’lf’ to ’crlf’, ’cr’ or ’lfcr’
[-I initsequence] Byte sequence at start of job
[-E exitsequence] Byte sequence at end of job
[-i inputcharset] Input character set . . .
[-o outputcharset] . . . maps to output character set

For example, to automatically add a “form feed” character to the last page of
each print job, the -f option must be specified:

$ pcfilter -f

“pcfilter” can also be called with the name of an exported printer. It references
an option list for the particular printer in the “Preferences” file. In the following
example a “form feed” flag for the printer “ljet” is set:

# prefvalue -k 'Printers/ljet/pcfilter/formfeed' -t bool TRUE
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Appropriate entries in the “Preferences” file are made automatically when you
export printers via HELIOS Admin. To choose print job filtering or character
set translation use PCShare Admin. This is much easier than doing it manually
(see 7.2 ““pcfilter” preferences”).

The “pcfilter” options in “Preferences” are:

formfeed

Add FF character to last page of job

ctrld

Filter Ctrl-D characters from job and prefix each job with “%!PS”

cr (=crlf)

Convert CR characters to CRLF

cr (=none)

Strip CR characters

lf (=crlf)

Convert LF characters to CRLF

lf (=none)

Strip LF characters

init (=<string>)

Specify initialization string

exit (=<string>)

Specify exit string

input (=<name>)

File name of input character mapping table (optional)
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output (=<name>)

File name of output character mapping table (optional)

postscript

Resolves PostScript jobs

If specified, the parameters input=name and output=name must always be speci-
fied as a pair.

init and exit string are both limited to 1000 bytes in length.

PCShare has the following character mapping tables in “HELIOSDIR/var/
cmaps” for use by “pcfilter”:

iso7, iso8, pc, mac, ebcdic, epson, fx1050ibm, fx850ibm, hp

The ISO7 table only maps characters from hex. 00-7f. All other tables map all
characters from hex. 00-ff.

The Epson and EBCDIC tables are provided as examples only. The Epson
table is compatible with the FX10-50 and FX80-50 printers and the EBCDIC
table only maps the valid EBCDIC codes.

Note: If your print job contains character codes which are not specified (i.e. miss-
ing) in the chosen input table, these codes are ignored and an error message
is issued to the system message file. A maximum of 10 such messages are
written per print job.
If your print job contains character codes which are not specified in the
chosen output table, these codes are ignored and not passed to the printer.

The tables are specially compiled binary mapping files which can only be
edited using PCShare Admin.
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You can also specify “pcfilter” for a local Windows printer which is configured
to receive print jobs from a UNIX spool queue. Here is an example from the
“Preferences” file:

[][Printers][epson-1][pcfilter][formfeed]
flags=0
type=Boolean
value=TRUE
[][Printers][epson-1][pcfilter][ctrld]
flags=0
type=Boolean
value=FALSE
[][Printers][epson-1][pcfilter][postscript]
flags=0
type=Boolean
value=FALSE
[][Printers][epson-1][pcfilter][exit]
flags=0
type=String
value=[4]
\007
[][Printers][epson-1][pcfilter][input]
flags=0
type=String
value=[4]
iso8
[][Printers][epson-1][pcfilter][output]
flags=0
type=String
value=[2]
pc

pcfilter and Windows PostScript jobs

“pcfilter” can also be used to correct several PC-specific problems which can
occur when printing to a PostScript printer which is connected to the host via
a network.

Particularly when printing PostScript from Microsoft Windows, a “Ctrl-D”
character is often included with the print job data to indicate end-of-job to the
printer.

If you are using a PostScript printer with a network connection, it is necessary
to filter out the “Ctrl-D” since it will cause a printer error. This is because
it is the responsibility of the print server and not of the application program
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to signal end-of-job in a way appropriate to the chosen hardware interface
(RS-232, Ethernet, etc.).

Furthermore, some PostScript printers expect the character string “%!PS” at
the very beginning of each PostScript print job. If this string is missing it is
assumed that the file is plain text, which is then automatically converted to
PostScript before printing, resulting in the printout of a PostScript program
listing rather than the print job itself.

If you are using a PostScript printer connected to the host, you can filter out
“Ctrl-D” characters and add “%!PS” to the start of each print job, by specifying
PCShare’s “pcfilter” utility in the UNIX print command.

An appropriate print command is created automatically when you configure
printers with PCShare Admin and choose a PostScript character mapping table.
See also the description of the magic preference in the HELIOS Base manual
for related information.

Note: When printing to an “lpr” printer queue, make sure that you switch off the Send
Ctrl+D Before Each Job and Send Ctrl+D After Each Job checkboxes
in the Windows printers preferences. Network printers do not understand
“Ctrl-D” characters.

Each PCShare SMB/CIFS queue contains the “pcfilter” program in its export
specifications. This is automatically set by the HELIOS Admin SMB/CIFS
printer publishing setup (Windows tab in the printer settings dialog).



37

5 Print to a HELIOS print queue
from a Windows network client

In general, it is advised to use the printer driver, e.g. PostScript driver, that fits
the printer model best.

In case of communication or output problems (the print job does not reach
the print server, the output is distorted, or a PostSript error is issued) you
should use a generic driver. For PostScript printers, you can use the Microsoft
PostScript Printer Driver »

Procedure:

â On your Windows client, go to the device and printer settings and open
the “Add Printer" dialog.

â Select to add a network printer.

â Select the desired network printer and confirm the No driver foundwarning
with OK.

â In the “Manufacturer” list select Generic, and from the “Printers” list MS
Publisher Imagesetter.

The printer has now been successfully installed.

â Confirm your selection, print a test page and finish the installation process.

https://msdn.microsoft.com/en-us/library/windows/hardware/ff556561(v=vs.85).aspx
https://msdn.microsoft.com/en-us/library/windows/hardware/ff556561(v=vs.85).aspx
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6 Client tools

6.1 HELIOS PCShare Client Tools

The HELIOS PCShare Client Tools are:

m UNIX file permissions for Windows Explorer

m HELIOS Meta information

m HELIOS PCShare Search

m HELIOS CLI tool “helsearch.exe”

Each HELIOS PCShare Client Tools functionality is described in the following
sections.

Preparing the installation

If the PCShare “Explorer UNIX permissions” shell extension was already
installed, please uninstall the old version before installing the new tools.

Uninstalling older versions of the PCShare Client Tools

Use the Windows “Add or Remove Programs” Control Panel to uninstall older
versions of the “PCShare Client Tools”.

Installing the PCShare Client Tools

The PCShare Client Tools must be installed locally in order to provide the
additional Windows Explorer UNIX permissions, HELIOS Meta information,
and the PCShare Search function.
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â Map the network drive “HELIOS Applications”, double-click the file
“setup.exe” from “Windows > PCShare Tools > PCShare Client Tools” and
follow the instructions in the installation dialog.

Note: The following functionality is only supported up to Windows XP/Server 2003:

Windows Explorer can display information on UNIX file permissions for
owner, group and others as well as meta data like label color and comments
provided by the PCShare Client Tools in own columns.

â To activate these columns, do a right-click on the column header in the
Windows Explorer file browser and activate in the pop-up menu those
items that should be displayed (scroll down in dialog; all options start with
“HELIOS)”.

6.1.1 PCShare UNIX file permissions

PCShare allows the user to review and change UNIX file and folder permissions.
Items that can be modified are UNIX file permissions, user, and group.

The benefit is that you have transparent permissions between Windows, UNIX,
Mac, and web clients. Permissions can easily be changed in the PCShare tab of
the Windows Properties dialog (Fig. 6.1).
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Fig. 6.1: Managing UNIX file/folder permissions

Mapping the network drive

The volume for which you wish to review or change UNIX file and folder
permissions must be mapped as a Windows network drive, otherwise the
PCShare tab will not be available in the Properties window.

â In My Network Places open Tools > Map Network Drive..., and select from
the Drive pop-up menu a letter for the network drive, e.g. “Z:”. From
the Folder pop-up menu select the volume path which you want to map
to the network drive. You may also browse for a volume by means of the
Browse... button.
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Managing permissions

In the “PCShare UNIX file permissions” section you can now specify access
rights according to your needs.

If you activate the checkbox Change permission on all files in every subdi-

rectory, which applies your permission changes to all files below the path, the
option Change the ownership/group for all files becomes available. This op-
tion has almost the same effect as the one described above, with the difference
that it applies all owner/group related changes to files below the path. To set
advanced file and directory permissions, click the Advanced... button. A new
window opens (Fig. 6.2), allowing you to set additional flags, e.g. the execute
flag for user, group, and other.

Fig. 6.2: Advanced UNIX file/folder permissions

To have the Advanced... button available without being logged-in as “root” on
the network drive, you can temporarily log in as “root” by clicking the button
Login as another user. A dialog opens that allows you to log in as a different
user.
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6.1.2 HELIOS Meta information

The HELIOS Meta information tab (Fig. 6.3) is a PCShare feature, which has
been installed with the shell extension (see Installing the PCShare Client Tools).

Fig. 6.3: HELIOS Meta information tab

This tab in the file/folder “Properties” allows adding a file comment and
mapping a color label to the file.

Color Labels

You can define seven color labels in HELIOS Admin that will be available on
Windows, Mac or WebShare clients. See the HELIOS Base manual for details.
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â Click the Import Server Colors button to load the color label scheme from
the server.

Comment

PCShare allows adding file comments to a file or folder. They are available on
Windows, Mac or WebShare clients.
The comments are stored in file streams as SFM compatible AFP comments
and work on any local NTFS disk and PCShare network drive. Comments
are limited to 199 bytes. (Please note that comments are stored in UTF-8
encoding in which special characters and umlauts require more than one byte
per character.)

â Enter a file comment in the Comment field.

In the example above, the file “Cafeteria” has been assigned the color label
“green” and a comment.

6.1.3 HELIOS PCShare Search

This feature allows you to search in a HELIOS volume that is mapped as a
network drive for files and folders. The search is realized in the index database
of the respective HELIOS volume. This results in a considerably faster search
compared to the standard Explorer file search, especially in larger volumes.
This is because there is no need to search the complete volume. The search
can even be limited to the current folder by starting the search from within the
respective folder.

The HELIOS Spotlight search allows for full-text searches. PDF files, Office
documents, text files, and Adobe InDesign and QuarkXPress preview files
are fully supported. Also searches based upon image attributes, document
metadata, XMP metadata of images, WebShare annotation information and
PDF form fields can be performed.
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General search

â In Windows Explorer highlight the HELIOS network drive, or a file/folder
within this network drive, on that you want to perform the file search.

â Then open HELIOS PCShare Search (Fig. 6.4) via the right mouse button,
from a folder context menu.
Alternatively, the HELIOS application “helsearchwin.exe” can be launched
directly from the “HELIOS PCShare Client Tools” directory (in the “Pro-
gram Files” directory).

Fig. 6.4: “HELIOS PCShare Search” request window

The Files on pop-up menu displays the selected target destination (mapped
HELIOS network drive) for the file search (“Z” in the example above). To
search in a different place, the respective HELIOS network drive letter must
be selected from this pop-up menu. For this to work, the directory must be
mapped as a network drive.

â In the text field enter the search term and select from the pop-up menu
whether the search term should be contained in the file name (Filename
Contains) or be an exact match (Filename Exact Match). Or select Spotlight
Search (see Spotlight search) as can be seen in Fig. 6.4 and Fig. 6.5.
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In addition, you may restrict the search results by use of the modification date
(Modified pop-up menu) and by limiting the results to a certain number of hits
(Max. Results pop-up menu).

â Click the Search button.

Fig. 6.5: “HELIOS PCShare Search” result window

In the example above we searched, on the network drive “Z”, for files in the
RGB color space with a resolution of more than 72 dpi. The result (Fig. 6.5)
displays 5 files matching the search conditions.

A double-click on an entry in the search results list will open the file in an
appropriate program. The context menu (via the right mouse button) allows
opening the enclosing folder of the selected file. The status line states the
number of search results (compare Fig. 6.4 and Fig. 6.5).

Note: Searches for names and text searches are case-insensitive, i.e. if you
search for “Portrait” the result would be the same as searching for “portrait”.

â To terminate the search and to close the window press the escape button.
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Spotlight search

If the Spotlight Search search criteria is selected from the pop-up menu, you
can also search for full-text, document metadata and image attributes.

The type of search is facilitated by a list providing all searchable metadata and
attributes:

â Click on the button to open a dynamically generated list of all indexed
metadata attributes for the current volume.

â Select the desired attribute from the list, which will then automatically be
preset in the search field.

Note: The button opens a help page in the web browser, which lists common
Spotlight search examples.

Spotlight search details are described in the chapter “Searchable metadata
attributes” in the HELIOS Index Server manual.

6.1.4 HELIOS CLI tool “helsearch.exe”

“helsearch” is a command line search program which allows you to find files
in a PCShare network drive by means of file name, file attributes, text con-
tent, and metadata. Full-text searches of PDF files, Office documents, text
files, and Adobe InDesign and QuarkXPress preview files are fully supported.
“helsearch.exe” is the CLI version of the GUI-based PCShare search (see
6.1.3 “HELIOS PCShare Search”) and is suitable for scripting purposes.

Usage:
helsearch.exe [-A][-c][-e][-f][-r][-s][-t][-h]

<Drive:[\path\scope]> <pattern> <searchterm>

-A List available Spotlight search attributes for <Drive:>
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-c If output is written to a console send output to console in Unicode
mode. Without this option and in all other cases output is written
in UTF-8

-e (File name search only): matches partial file names

-f File name search instead of Spotlight search (conflicts with -s)

-r Print file names in HELIOS convention (e.g. “/C:/Helios/bin/
swho.exe” instead of “C:\Helios\bin\swho.exe”)

-s <pattern> uses advanced Spotlight syntax

-t Print modification date (seconds since January 1, 1970) and file
name

-h Print this help

More details on the HELIOS Spotlight search, and search options, are covered
in the HELIOS Index Server manual, in the chapters “Simple Spotlight search
syntax” and “Advanced Spotlight search syntax”.

6.2 HELIOS LanTest

HELIOS LanTest is a tool for testing and measuring the performance of file
system and print system services. It offers detailed evaluations for file and
record locking on file server volumes, as well as for many typical file system
operations. LanTest results can be used to find bottlenecks, for troubleshooting,
or just for maintenance purposes.
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Fig. 6.6: HELIOS LanTest dialog

The HELIOS LanTest tool is available in the “HELIOS Applications” volume
in Windows > PCShare Tools > HELIOS LanTest.

â Copy “HELIOS LanTest.exe” to your Windows PC.

â Start HELIOS LanTest (Fig. 6.6). From the File menu select Choose Test

Volume... and click the Choose button.
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â Next, click on the Network pop-up menu, and select the network type you
are connected to (Fig. 6.7). Depending on the network specified in this
window, LanTest determines the test load, i.e. the size of test files that are
processed at a time.

This makes sense because Fast Ethernet (100 Mbit/s) networks have a higher
data throughput than the standard Ethernet (10 Mbit/s). Gigabit Ethernet
reaches a data throughput of up to 1 Gbit/s (1000 Mbit/s), 10 Gigabit Ethernet
up to 10 Gbit/s (10000 Mbit/s), and 40 Gigabit Ethernet up to 40 Gbit/s (40000
Mbit/s).

Fig. 6.7: Other settings dialog
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7 Preferences

This chapter lists all the preferences that are pertinent to PCShare. Find a
description of how to set, view, change or delete preferences, with the HELIOS
utility programs “prefdump”, “prefvalue”, and “prefrestore”, in the HELIOS
Base manual.

Important: Make sure that preference keys DO NOT start or end with a slash (“/”)
character, and note that they are case-sensitive! Also, if any preference key
or preference value includes spaces, that key or value must be enclosed in
quotes.

7.1 PCShare preferences

The following keys require a restart (see “srvutil” in the HELIOS Base manual) of
the service to take effect:

Key: Programs/pcshare/<preference>

locks int (see description)

Specifies the number of “file and region locks” that the server allows
simultaneously (if EtherShare is installed on the same server it must
be allocated the same settings).
The default for this parameter is sessions*(files+20), where “ses-
sions” is equal to the number of units (clients) for which you bought
your license and “files” is the maximum number of of files (see
files preference).
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Do not set this preference to an unnecessary high value because
this increases PCShare’s requirement for UNIX system resources.

offerNTCaps bool TRUE

If set to FALSE, an “older” protocol version compatibility mode is
activated, for e.g. Windows 9x, but not NT.

unicode bool TRUE

Offers Windows clients to use Unicode based file names.

oplocks bool TRUE

Files which are accessed from the file server are locally cached.
This brings a significant speed up to file access.

advertizedinterfaces strlist ""

Specifies the IP address the “pcshare” program offers to the SMB
clients for logging in via IP-protocol. (If this value remains un-
specified, i.e. empty, all IP addresses on all network interfaces are
offered.)

files int <see text>

This preference specifies the maximum number of files that can be
opened by one file server process simultaneously. The achievable
maximum cannot exceed the maximum number of open files per
process currently allowed by the host. To save system resources, do
not set this value larger than set by the “ulimit” UNIX command.
The default value for this preference is 8192, and 2048 on OS X
platforms.

dirs int <see text>

Specifies the number of shared memory slots that are used to syn-
chronize changes between PCShare and AFP server. This becomes
necessary if the content of a directory changes (by creating or delet-
ing a file) and the other service (“afpsrv” or “pcshare”) must be
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informed of that change in order to read in the directory anew, and
to display the updated content correctly.
Each directory has a hash value that refers to one of the slots.
Large values for this preference have the advantage that different
directories very rarely refer to the same slot. If different directories
referred to the same slot (A, B, C and D refer to slot 123) changing
Cwould cause A, B, C and D to be read in anew. The only drawback
is a higher memory consumption (RAM) in the shared memory.
However, each entry (slot) only uses 4 bytes and is valid for all
clients – why it is only used once.
Small values lead to unnecessary directory read ins while consum-
ing insignificantly less memory (RAM).
The default value is 16384 (16*1024). It should be raised if the
directory usage of all used volumes (sum over all directories in
use) exceeds about 1/4 of the current value.

comment str "%n %p"

Comment field for the server in the Network Neighborhood field of
the Windows client.
The default is built from the machine name and the PCShare server
version, e.g. sun4100 PCShare 6.0.

Note: As of Windows Vista, this comment is no longer displayed in
Windows Explorer.

FSTunnelCache int 0

Specifies the number of entries per directory that should be held in
the tunnel cache. A reasonable default value is 16.
Background: The cache holds the creation date and ensures that
long/short file names are retained after renaming or deletion. You
could try to set this preference if you experience problems upon
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saving documents from applications that depend on the older MS-
DOS behavior.
For more information see the Windows NT Contains File System
Tunneling Capabilities document.

FSTunnelCacheTimeout int 15

Specifies the time in seconds before a cache entry expires.

hostname str <hostname>

Specifies the name PCShare uses to register in the SMB domain/
workgroup for the Windows Network Neighborhood.

logdenied bool FALSE

If set to TRUE, this preference lets “pcshare” append a record to the
system messages if, due to the IP access list, access to one or more
users has been denied.

logNoMount bool FALSE

If set to TRUE, this preference makes PCShare also log guest user
logins who have mounted control shares (“IPC$”).

telnetport int 2003

Specifies the port number of the Telnet service port where NBS and
status information can be queried (see 4.2.4 “Querying PCShare
for WINS & Configuration information”).

RemoteAccess bool FALSE

If set to TRUE, access to the PCShare service port (2003) is enabled
to remote users (subject to the restrictions in the ipaccess list). The
default is that access to the PCShare service port is only enabled
for users on the same host.

ipaccess str "var/conf/ipaccess"

Specifies the path of the file containing the access list with the IP
addresses which are permitted to log on to “pcshare”.

http://support.microsoft.com/kb/172190/en-us
http://support.microsoft.com/kb/172190/en-us
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staticaddresses bool TRUE

Specifies if DHCP static “Ethernet-to-IP address” mappings, which
are defined in “/etc/bootptab” or “/etc/ethers”, are used too.

nameserver str ""

Specifies the IP address of the primary WINS server.

nameserverbackup str ""

Has the same effect as nameserverbackup (see above), but only
takes effect if the primary name server fails.

enablewins bool FALSE

Specifies whether the built-in WINS server is switched on.

nowinsbackup bool FALSE

Specifies whether saving the WINS data to file is switched off.

enableproxy bool FALSE

If specified, broadcasting nodes can see WINS clients on other
subnets but may get confused due to the increased name resolution
network traffic.

enableproxyregcheck bool FALSE

Can only be used in conjunction with the enableproxy preference.
It helps to avoid duplicate computer names. Duplicate computer
names in one network will not work reliably.

domainname str "WORKGROUP"

Specifies the name of the SMB domain/workgroup in which PC-
Share is registered.

primarydomaincontroller bool FALSE

If set to TRUE, PCShare simulates a Primary Domain Controller.
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avoidelections bool FALSE

Specifies if PCShare attempts to become LMB.

scopeid str ""

This preference is usually not set. If the Windows PC is configured
to use a scope identifier it needs to be identical with the server’s
scope identifier.

Note: This preference is also used by the DHCP server, which is part
of the HELIOS Base software.

7.2 “pcfilter” preferences

Key: Printers/<printer>/pcfilter/<preference>

ctrld bool FALSE

If set to TRUE, this flag filters out “CtrlD-D” characters which are
used to indicate “end-of-print-job”, and prefixes each job with
“%!PS”.

formfeed bool FALSE

Adds a “form feed” character to the last page of the print job.

input str ""

Specifies the file name of the input character set mapping table.

output str ""

Specifies the file name of the output character set mapping table.

init str ""

Specifies the byte sequence at the start of a print job.
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exit str ""

Specifies the byte sequence at the end of a print job.

cr str ""

Specifies whether CR (carriage return) characters are converted to
CRLF (carriage return/line feed). Possible strings are: cr, lf, crlf,
lfcr, none

lf str ""

Specifies whether LF (line feed) characters are converted to CRLF
(carriage return/line feed). Possible strings are: cr, lf, crlf, lfcr,
none

postscript bool TRUE

Specifies if PostScript jobs should be resolved.

7.3 “smbif” preferences

Key: Printers/<printer>/<preference>

SMBPrinterHost str ""

(HELIOS Admin option Computer Name)
Specifies the Windows name (or the IP address/host name) of the
PC which the printer is connected to.

SMBPrinterUser str ""

(HELIOS Admin option User Name)
Specifies the name of the user who has shared the printer.

SMBPrinterPasswd str ""

(HELIOS Admin option Password)
Specifies the (encrypted) user password.
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SMBPrinterName str ""

(HELIOS Admin option Printer Name)
Specifies the name under which the printer is shared on the network.

SMBPrinterResolve bool TRUE

(HELIOS Admin option PostScript Printer)
If a file is sent to a Windows printer queue, with this option set to
FALSE, the print job remains “untouched” and is passed on without
any changes.
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A Connect Windows clients to the
PCShare server

If you should encounter any problems while trying to connect to a PCShare
server, you should verify the setup. In the following we give some proposals
for checking, step by step, that the software installation was successful and the
connection is working.

Note: In a complex network you may have to wait several minutes after starting
PCShare before a stable browsing hierarchy has been reached. You may
not see the workgroup/domain in the Windows My Network Places list.
Please look always into the system messages for PCShare related er-
ror/warning messages if a problem occurs.

A.1 IP configuration and Windows

The following tips may be helpful if a Windows client cannot see the PCShare
server:

Verifying the TCP/IP setup

Verify the Windows TCP/IP configuration by use of the “ping” utility, e.g. via
the Windows command prompt:

ping <PCShare server name>

Example:
C:\WINDOWS>ping druaga
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If the PCShare server is available by name “ping” returns the following protocol
on screen:

Pinging druaga [172.16.0.63] with 32 bytes of data:
Reply from 172.16.0.63: bytes=32 time<1ms TTL=64
Reply from 172.16.0.63: bytes=32 time<1ms TTL=64
Reply from 172.16.0.63: bytes=32 time<1ms TTL=64
Reply from 172.16.0.63: bytes=32 time<1ms TTL=64
Ping statistics for 172.16.0.63:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:
Minimum = 0ms, Maximum = 0ms, Average = 0ms

If the requested server (in this example “druaga”) is known to the network but,
for any reason, not up and running the protocol returns the following message:

Pinging druaga [172.16.0.63] with 32 bytes of data:
Request timed out.
Request timed out.
Request timed out.
Request timed out.
Ping statistics for 172.16.0.63:
Packets: Sent = 4, Received = 0, Lost = 4 (100% loss),
Approximate round trip times in milli-seconds:
Minimum = 0ms, Maximum = 0ms, Average = 0ms

If the PCShare server name is not detected on the network “ping” returns
Unknown host <PCShare server name>. In this case you should run “ping” again
trying the server IP address instead:

C:\WINDOWS\ping 172.16.0.63
Pinging 172.16.0.63 with 32 bytes of data:
Reply from 172.16.0.63: bytes=32 time<1ms TTL=64
Reply from 172.16.0.63: bytes=32 time<1ms TTL=64
Reply from 172.16.0.63: bytes=32 time<1ms TTL=64
Reply from 172.16.0.63: bytes=32 time<1ms TTL=64
Ping statistics for 172.16.0.63:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:

Minimum = 0ms, Maximum = 0ms, Average = 0ms

Note: If the client PC is running any firewall software, this software must be con-
figured to allow access between server and client. Refer to the instructions
of the firewall software.
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Verifying the user name

If the connection could not be established, check if your user name is known
to the PCShare server (e.g. in the Users tab in HELIOS Admin, see also the
chapter “HELIOS Admin” in the HELIOS Base manual).

Note: The user name for the Windows network login must match the user name
and password on the server. Otherwise Windows will return a “Network
Error”.
Under Windows 95/98/Me, you can only mount server volumes from the
Network Neighborhood dialog using the same login user name for client
and PCShare server. Under all other Windows clients, you can mount server
resources under a different user name.

Fig. A.1: Searching directly in Windows Explorer

Find server

â In Windows Explorer enter the server name or the IP address (Fig. A.1):
\\<server name> or \\<ipaddress> or \\<WINS name>
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A.1.1 Displaying the client’s TCP/IP settings

To check the Windows client’s TCP/IP configuration settings there are two
ways to obtain all the values at a glance:

Windows 95/98/ME

Under Windows 95/98/Me use “WinIPCfg”:

â To open “WinIPCfg”, click Start > Run and enter winipcfg in the Run field.

The window IP Configuration appears (Fig. A.2) displaying the settings of the
(physical) Ethernet Adapter Address, the IP Address, the Subnet Mask, and the
Default Gateway.

Fig. A.2: “IP Configuration” window (default)

You may want to check more TCP/IP settings, e.g. about installed DHCP, DNS,
and WINS server(s). To obtain this extended information do the following:

â Click on the More Info » button to get more detailed and comprehensive
information from the IP Configuration window.



A.1 IP configuration and Windows 63

Windows NT4 - Windows 10

Under Windows NT4 - Windows 10 enter the following command:

ipconfig /all

The output should look similar to this:

Windows IP Configuration
Host Name . . . . . . . . . . . . : chroma
Primary Dns Suffix . . . . . . . :
Node Type . . . . . . . . . . . . : Hybrid
IP Routing Enabled. . . . . . . . : No
WINS Proxy Enabled. . . . . . . . : No
DNS Suffix Search List. . . . . . : dyn.helios.de

Ethernet adapter Local Area Connection:
Connection-specific DNS Suffix . : dyn.helios.de
Description . . . . . . . . . . . : Intel(R) PRO/1000 MT Desktop Adapter
Physical Address. . . . . . . . . : 00-10-DC-CB-68-E7
DHCP Enabled. . . . . . . . . . . : Yes
Autoconfiguration Enabled . . . . : Yes
IP Address. . . . . . . . . . . . : 172.16.3.88
Subnet Mask . . . . . . . . . . . : 255.255.252.0
Default Gateway . . . . . . . . . : 172.16.0.3
DHCP Server . . . . . . . . . . . : 172.16.0.1
DNS Servers . . . . . . . . . . . : 172.16.0.1
Primary WINS Server . . . . . . . : 172.16.0.1
Lease Obtained. . . . . . . . . . : Tuesday, 23. May 2017 08:59:42
Lease Expires . . . . . . . . . . : Wednesday, 24. May 2017 00:59:42

A.1.2 The “Network” Control Panel

The configuration of your client’s network connection is done in the “Network”
control panel, where you can specify among other things DNS, WINS, and IP
address settings. This can be done statically or dynamically (DHCP).

These settings are available in the “Local Area Connection Properties”.

â In the configuration window (Fig. A.3) double-click the entry Internet

Protocol Version 4 (TCP/IPv4) network component.
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The Internet Protocol Version 4 (TCP/IPv4) Properties open, allowing you
to configure IP address, Gateway, DNS, NetBIOS, and WINS.

Fig. A.3: “Local Area Connection Properties” window

Obtain an IP address

Before you specify an IP address for your Windows client you have to know
whether the IP address is to be assigned manually (i.e. you specify it once
in the Internet Protocol Version 4 (TCP/IPv4) dialog) or dynamically (via
DHCP server).

â In the Internet Protocol (TCP/IP) Properties window (Fig. A.4) activate
the Obtain an IP address automatically checkbox if the IP addresses in
your LAN are administered by a DHCP server. Otherwise check Use
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the following IP address and enter the IP address and the subnet mask
values which your Windows client has been assigned by your network
administrator manually.

Fig. A.4: “Internet Protocol Version 4 (TCP/IPv4) Properties” window

Default gateway

To establish a connection with TCP/IP nodes that do not reside on the same
network segment (e.g. host requests within a wide area network) you will
need an interface which connects different network types. For this purpose
the protocols must be routed. Under TCP/IP this task is done by an interface
(gateway). You have to “tell” the Windows client the default gateway host that
has been configured on the PCShare server:

â Enter the IP address which your network administrator has assigned to the
interface in the Default gateway field.
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WINS configuration

To configure the WINS server manually (compare 4.2.2 “Name resolution with
WINS”), proceed as follows:

â In the Internet Protocol Version 4 (TCP/IPv4) Properties window click
the Advanced button and select the WINS tab from the Advanced TCP/IP Set-

tings window. Click the Add... button and enter the WINS server IP
address, which you obtain from your network administrator, and click the
Add button.

The IP address of the WINS server appears in the box below.

NetBIOS configuration

The scope identifier, that can optionally be entered in the field Scope ID, defines
a group of computers that recognize a registered NetBIOS name. Computers
with the same scope identifier will be able to recognize each other’s NetBIOS
traffic or messages. This value is used to specify the Windows client’s scope
identifier if required on a network that uses NetBIOS over TCP/IP.

Note: The scope identifier is case-sensitive.

DNS configuration

For simple file sharing purposes within the LAN, a DNS server is not required
since name resolution is done by WINS. However, if you want to contact
servers outside the LAN, e.g. browsing the World Wide Web, and thus need
host name resolution, you have to configure a DNS server:

â Click the Add... button and enter the DNS server IP address, which you
obtain from your network administrator, and confirm with Add.
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B Technical notes

The following section contains miscellaneous technical information about
PCShare. It is primarily of interest to experienced system administrators only.

B.1 PCShare 2.5 compatibility

The tar archive “HELIOSDIR/etc/pcscompat/pcapps25.tgz” contains the PC-
Share 2.5 client compatibility files that are needed for connecting PCShare
MS-DOS and Windows 3.x clients. If you need PCShare 2.5 client compati-
bility, execute the following commands as “root ”:

# cd /usr/local/helios
# bin/stop-helios now
# gunzip < etc/pcscompat/pcapps25.tgz | tar xvf -
# bin/prefrestore etc/pcscompat/pcsdossrv.prefs
# bin/start-helios -i

All files will be extracted into the “HELIOSDIR/public” folder.

Note: All DOS/Windows PCShare clients require a valid static or DHCP client
TCP/IP configuration.
The automatic PCShare 2.5 TCP/IP assignment for DOS/Windows 3.x
clients is not supported anymore.
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C Glossary

Driver

A program which is part of the operating system of a computer and controls
part of the computer hardware.

EtherShare

A program developed by HELIOS for Mac networks. It allows among other
things the sharing of hard disks (file server functionality) and printers (print
server functionality), and uses the TCP/IP and AFP protocols for network
communications. Since EtherShare is compatible with PCShare andWebShare,
Mac users can share network printers and files with Mac, Web, and UNIX
users, too.

ImageServer

An optional add-on, which considerably speeds up print spooling if you are
printing DTP layouts containing large high-resolution images. OPI (Open
Prepress Interface) is an interface specification which was developed by Aldus
Corp.

PDC

PDC (Primary Domain Controller) can be 1. In Windows NT, a database
providing a centralized administration site for resources and user accounts.
The database allows users to log onto the domain, rather than onto a specific
host machine. A separate account database keeps track of the machines in
the domain and allocates the domain’s resources to users. 2. In any local
area network, the server that maintains the master copy of the domain’s user
accounts database and that validates logon requests.
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SMB/CIFS

The Server Message Block protocol (SMB protocol) provides a method for
client applications in a computer to read and write files to, and request services
from server programs in a computer network. The SMB protocol can be used
over the internet on top of its TCP/IP protocol or on top of other network
protocols such as Packet Exchange and NetBEUI. Using the SMB protocol, an
application (or the user of an application) can access files at a remote server as
well as other resources, including printers, mailslots, and named pipes. Thus,
a client application can read, create, and update files on the remote server. It
can also communicate with any server program that is set up to receive an
SMB client request.

Microsoft Windows operating systems since Windows 95 include client and
server SMB protocol support.

Common Internet File System (CIFS) is a proposed standard protocol that lets
programs make requests for files and services on remote computers on the
network. CIFS uses the client/server programming model. A client program
makes a request of a server program (usually in another computer) for access
to a file or to pass a message to a program that runs in the server computer.
The server takes the requested action and returns a response. CIFS is a public
or open variation of the SMB protocol developed and used by Microsoft. The
SMB Protocol is widely used in today’s local area networks for server file
access and printing.

Like the SMB protocol, CIFS runs at a higher level and uses the internet’s
TCP/IP protocol. CIFS is viewed as a complement to the existing internet ap-
plication protocols such as FTP (File Transfer Protocol) and HTTP (Hypertext
Transfer Protocol).

CIFS lets you:

m Get access to files that are local to the server and read and write to them

m Share files with other clients using special locks
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m Restore connections automatically in case of network failure

m Use Unicode file names

TCP/IP

An internet network is a virtual data network specification based on a packet-
oriented protocol (the internet protocol = IP) which allows data to be transferred
between otherwise incompatible networks. Thus, the internet specification
describes a hardware-independent data protocol that lies above the hardware
protocol (such as Ethernet). The Internet Protocol (IP), however, is only able to
exchange data packets between computers. The Transmission Control Protocol
(TCP) extends this ability to allow processes to be addressed on the target
computer and to improve the reliability of the inter-process communication.
TCP/IP has been implemented by all major software and hardware providers.

WebShare

WebShare is a high-performance HELIOS file server which enables fast and
secure real time file access via any web browser. SinceWebShare is compatible
with PCShare and EtherShare, Web users can share network printers and files
with Mac, Windows, and UNIX users, too.

Workgroup

A group of users working on a common project and sharing computer files,
often over a local area network.

Workstation

Any computer which is not used as a server connected to a network for example
a Mac computer, or a PC-compatible computer.
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